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1. Introduction to the Tutorials
Though these tutorials are written for Genie™ 2000’s Model S501 Gamma Analysis
Software, the Model S509 Alpha Analysis Software is similar enough that using these
tutorials shouldn’t cause any confusion.

• The user interface, starting on page 2.

• Basic Genie 2000 operations, starting on page 11.

• Basic energy calibration techniques, starting on page 21.

• Basic efficiency calibration techniques, starting on page 25

• Basic analysis techniques in three parts, starting on page 29.

� Executing a Module Interactively

� Executing an Analysis Sequence

� Editing an Analysis Sequence

The first tutorial, “The User Interface”, describes the main features of the application’s
user interface.

The remaining tutorials are brief introductions; their functions are covered more thor-
oughly in one of two documents:

• The Gamma Acquisition and Analysis chapter of the Genie 2000 Operations
Manual.

• The Model S509 Genie 2000 Alpha Analysis User’s Manual, which is included
at the back of the Genie 2000 Operations Manual.

Glossary
A comprehensive glossary of  nuclear spectroscopy terms is included at the back of
this document, starting on page 39.

A Prerequisite to Using the Tutorials
Before you can use these Tutorials with Genie 2000, you must have created at least
one MCA Input Definition with either the MID Wizard or the MID Editor. Instructions
for using both of these are provided in the MCA Input Definition chapter of the Genie
2000 Operations Manual.



2. The User Interface
The Acquisition and Analysis window (Figure 1) is Genie™ 2000’s user interface for
acquiring and analyzing nuclear spectra. Since the Gamma A&A window (GAA) is
similar to other Genie 2000 application windows, it’ll be used as a quick introduction
to the parts of the window.

It consists of the Title Bar, the Menu Bar, the Toolbar and the Display Status Line at
the top of the screen, the Control Panel, the Spectral Display, the Status Pages, and the
Report Window in the main part of the window, and, at the bottom of the screen, the
Analysis Status Line.

The Top Four Lines
The four lines at the top of the screen are the Title Bar, the Menu Bar, the Toolbar and
the Display Status Line.
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Figure 1 The Basic Acquisition and Analysis Window
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The Title Bar
The Title Bar, at the top of the screen, always shows the application’s name. If a
datasource has been opened, the datasource’s file name will also be displayed
(Nbsstd.cnf in Figure 2). If more than one datasource is open, the name of the current
one is displayed.

The Menu Bar
The Menu Bar, just below the Title Bar, presents you with a choice of top-level menu
functions (Figure 3). Each of the submenus’ functions is covered in detail in your
Gamma Acquisition and Analysis chapter or Alpha Analysis Manual.

The Toolbar
The Toolbar (Figure 4), directly under the Menu Bar, contains buttons corresponding
to common menu commands. Throughout these tutorials, you’ll find examples of us-
ing Toolbar buttons, each with an illustration of its icon. If you rest the mouse cursor
(page 13) on an icon for a short time, you’ll see a tooltip describing its action.

If you don’t see the tooltips, select the “Show Tooltips” checkbox in Display | Prefer-
ences | Toolbar Setup | Toolbars. Before closing the Toolbar Setup page, check or
uncheck the “Cool Look” checkbox. You’ll immediately see another way of display-
ing the Toolbar. Figure 4 shows the Toolbar with the “Cool Look” box unchecked.
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Figure 2 The Title Bar

Figure 3 The Menu Bar

Figure 4 The Toolbar



Display Status Line
The Display Status Line (Figure 5) is between the Menu Bar and the spectrum. It dis-
plays the current status, such as Idle, Busy or Done, and the position of the spectrum
cursor (page 13) in terms of both channel and energy, and the total counts at that loca-
tion. The Preset at the right shows 2000/1826.00, the values for the preset setting and
the elapsed preset.

How to Use the Control Panel
The Control Panel (Figure 6), on the left-hand side of the screen, provides easy access
to the functions used in daily operations: Acquire Start/Stop, Expand On/Off, Clear
data and time, ROI Indexing, and moving forward/backward through the list of all
open datasources.
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Figure 5 The Display Status Line

Figure 6 The Control Panel



You can make the spectral display area larger by hiding the Control Panel: select Dis-
play | Preferences, then remove the check from the Control Panel Shown check box.

Acquire Start/Stop
Clicking on these buttons starts or stops data acquisition. The buttons are disabled for
files and for detector datasources that are opened as Read Only.

Expand On
Clicking on this button toggles the state of the Expanded Display. See “Expand” on
page 16 for more information.

Clear
Clicking the Clear button, which is enabled only for detector datasources, clears all
spectral data and time information from the currently displayed datasource.

ROI Index
To quickly move the markers through the spectrum, from one ROI (Region of Interest)
to the next, you can:

• Click one of the Control Panel’s ROI Index buttons. The (+) button moves one
ROI to the right and the (–) button moves one ROI to the left.

• Use the keypad’s (+) and (–) keys.

• Click one of the ROI Index buttons in the Toolbar.

Datasource
If more than one datasource is open, you can click on Next or press the F6 key to
change the display to the next datasource in the list of all open datasource. If you click
on Prev or press SHIFT+F6, you’ll display the previous datasource.

If less than two datasources are open, these buttons will be disabled (grayed out).

Up to 48 Detector and File Inputs in any combination may be opened and up to eight
can be displayed simultaneously.

Similarly, other open Detector Inputs or File Inputs (as well as multiple memory
groups) can be selected for display from the list of currently open Detector Inputs or
File Inputs.
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How to Use the Spectral Display
The Spectral Display (Figure 7) shows the current spectrum. The upper right corner of
this area will show the display’s current VFS (vertical full scale) setting.

Changing the VFS
The scroll bar on the right side of this area lets you manually adjust the VFS.

How to Use the Status Pages
Detailed information about the current datasource can be seen in the Status Pages dis-
played below the spectrum.

You can move through the pages by selecting the Next or Prev button in the Status
Page area or by pressing keyboard’s PG DN or PG UP key. You can make the spectral
display area larger by hiding the Status Pages: select Display | Preferences, then re-
move the check from the Status Page Shown check box. In addition, you can chose
which status pages to display by selecting Display | Preferences, then the Status
Pages button.

Note that some of the data shown on the Status Pages is the result of a rough calcula-
tion for the region between the markers. This means that this displayed data may not
agree with the data you see in a report generated by your analysis application.

Only the four default Status Pages are described here. For information on the other
pages, refer to the “Display Menu | Screen | Status Pages” section of your Gamma Ac-
quisition and Analysis chapter or Alpha Analysis Manual.
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Figure 7 The Spectral Display



The Time Info Page
The Time Info status page (Figure 8) includes: acquire start time, percent dead time,
computational preset region, and elapsed and preset values.

The Sample Info Page
The Sample Info status page (Figure 9) includes sample-related information: Title,
ID, sample type, quantity and units, sample geometry, geometry id, and buildup type.

The Nuclide Info Page
The Nuclide Info status page (Figure 10) includes estimated nuclide information for
the location of the spectrum cursor (page 13): Nuclide, Energy, Half-life, and percent
Yield. If the cursor is within an ROI then the FWHM, Area, and estimated Activity are
also displayed.
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Figure 8 The Time Info Page

Figure 9 The Sample Info Page

Figure 10 The Nuclide Info Page



The Marker Info Page
The Marker Info status page includes data related to the current Region of Interest
(ROI): left and right marker channel and energy, centroid channel and energy, area
and percent error, FWHM and FWTM, Gaussian ratio, ROI type, and integral.

How to Use the Report Window
The Report Window (Figure 12) displays reports that have been created either interac-
tively or automatically by the system.

Select the Options menu item, then Report Window to see commands to copy the data
to the clipboard, to clear the data from the window, and to change the size of the win-
dow for easier report viewing.

Copy (Highlighted) Data to Clipboard
To copy the entire report, select Options | Report Window | Copy Contents to
Clipboard.

To copy just the highlighted portion, created by dragging your mouse cursor (page 13)
over the data of interest, select Options | Report Window | Copy Highlighted to
Clipboard.
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Figure 11 The Marker Info Page

Figure 12 The Report Window



Printing the Report Window
To print the data in the Report Window, select File | Print Report Window.

Clearing the Report Window
You’ll have to clear the Report Window if you want to display the next report’s data
by itself. If you don’t clear the Report Window, the next report will be appended to the
current report.

There are two ways to clear the window:

• Select the menu’s Options | Report Window | Clear Contents command.

• Click the Toolbar’s “trashcan”.

Resizing the Report Window
There are two ways to make the Report Window larger or smaller or reset it to its de-
fault size:

• Select the menu’s Options | Report Window | Minimize or Maximize or De-
fault Size command.

• Click one of the Toolbar’s report window icons.

How to Use the Analysis Status Line
The Analysis Status Line at the bottom of the screen (Figure 13) displays the execu-
tion status during various phases of an analysis.

How to Use the the Menu Commands
The Gamma Acquisition and Analysis window’s Menu Bar contains the title of each
of eight main command groups: File, MCA, Calibrate, Display, Analyze, Edit, Options
and Datasource, as well as Help.

The File Menu
The File menu lets you open, close or save a datasource, save it under another name
(save as), access print options for the current spectrum and Report Window, access
workspace files, and exit the program.
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Figure 13 The Analysis Status Line



The MCA Menu
The MCA Menu’s commands include starting and stopping data acquisition, setting up
the acquisition parameters, clearing the spectral display, adjusting the hardware
datasource’s programmable controls, checking the status of all MCA devices, advanc-
ing to the next sample in a sample changer, and loading a data file into the current
datasource.

The Calibrate Menu
The Calibrate Menu lets you set up calibration preferences, perform energy, efficiency
and peak-to-total calibrations, show the results of a calibration graphically, and load a
calibration file into the current datasource or store the datasource’s calibration as a
file.

The Display Menu
In the Display Menu, you’ll find commands for expanding and scaling the display,
comparing two datasources, entering or deleting ROIs (regions of interest), and setting
display preferences.

The Analyze Menu
The Analyze Menu’s commands let you execute a single analysis step or a sequence of
analysis steps. Every Genie 2000 system includes the acquisition, peak locate, peak
area, reporting, post-NID processing and datasource saving steps.

If your system includes the Model S501 Gamma Analysis option, the area correction,
efficiency correction, nuclide identification and detection limits steps are added. Any
other installed options will add their own steps.

The Edit Menu
The Edit Menu allows you to enter and edit Sample Information and define and edit
Analysis Sequences.

The Options Menu
The Options Menu lets you change the operator’s name, initiate interactive NID,
launch the geometry composer, perform strip and smooth, and work with the report
window.

The Datasource Menu
The Datasource Menu lets you display up to eight of the currently open datasources. If
the datasource is a multi-memory group input, you’ll be able to move from one group
to another.
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3. Basic Genie 2000 Operations
For the procedures covered in this chapter, the Model S500/502/504 Basic Spectros-
copy Software must be running.

This tutorial is intended to be a brief overview of the basic Gamma Spectroscopy
Analysis window and of some of its functions. The Alpha Spectroscopy Analysis win-
dow is very similar, so Alpha users can benefit from this tutorial as well.

The first step in learning how to use Gamma Spectroscopy Analysis is to get some
data to work with. This process is called opening a datasource, where the source for
the data can be a Detector or a data file. For this tutorial, we’ll open a data file.

How to Open a Datasource
There are two ways to open a datasource:

• Select the menu’s File | Open Datasource command.

• Click the Toolbar’s open datasource icon.

Either way, the dialog box in Figure 14 will be displayed.
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1. Source: If it’s not already highlighted, select the File button.

2. Type: Select CAM File. CAM stands for Configuration Access Method, a
type of data file which contains a spectrum, its Regions of Interest (ROIs), its
calibration information, etc.

3. Read Only: This checkbox should not be checked.

4. Look in: Navigate to C:\GENIE2K\CAMFILES and select Nbsstd.cnf, the
NBS Standard spectrum file.

5. Click Open.

How to View the Data
The name of the datasource you just opened can be seen in the window’s Title Bar,
and the data itself in the window’s Spectral Display area as seen in Figure 15.
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Figure 15 A Typical Gamma Display



A. The Display’s Vertical Full Scale
The spectral display’s Vertical Full Scale (VFS) defaults to Linear Autoranging. That
is, the vertical scale is linear rather than logarithmic, and the smallest VFS which will
contain the tallest peak in the data is automatically picked for you.

The VFS being used is always displayed in the upper right-hand corner of the spectral
display as either VFS=nnnn for a Linear scale or LOG=nnnn for a Logarithmic scale,
where nnnn is the vertical full scale value.

How to Change the Scale Manually
There are several ways to change the Vertical Full Scale by a factor of two (1024,
2048, 4096, etc.):

• Click on the upper or lower part scroll bar at right of the data display.

• Drag the scroll bar’s slider up or down.

• Use the keyboard’s up and down arrow keys. Each press of an arrow key is the
same as clicking once on the corresponding end of the scroll bar.

To toggle between Auto and Manual, press the keyboard’s F5 key.

Linear or Log Mode
There are two ways to change between Linear and Log data display:

• Select the menu’s Display | Scale | Linear or Log command.

• Click one of the Toolbar’s display mode icons.

How to Use the Cursors
Genie 2000 uses two kinds of cursor:

• The mouse cursor.

• The spectrum cursor.

Move the mouse cursor to the middle of the spectrum, hold down the left mouse
button and move the cursor to the left and right. You’ll see a short vertical bar, the
spectrum cursor, following your mouse’s movement.

Moving the Spectrum Cursor
Any time you point and click within the data display, the spectrum cursor will imme-
diately jump to the channel which corresponds to the horizontal location of the mouse
cursor. In addition, you can also move the spectrum cursor by:

• Dragging it across the data by holding the left mouse button down while you
move the mouse.
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• Using the keyboard’s left and right arrow keys to move the spectrum cursor
through the data.

As you move the spectrum cursor, watch the Display Status Line (Figure 16). You’ll
see the information displayed there, the current channel number, its energy, and the
number of counts in that channel, change with the cursor’s movement. The word Idle
at the far left lets you know that no data acquisition is under way.

How to Use the Markers
In addition to the spectrum cursor, which is used to examine individual channels of
data, the spectrum also includes a pair of region markers that are used to measure
things like peak areas and centroids. These are initially located on either side of the
first ROI (Region of Interest), if there is one. If there is no ROI, they are at either end
of the full spectrum.

The region markers look like an “upside down L”, with the horizontal part pointing to
the left for the left marker, and right for the right marker. Figure 17 on page 15 illus-
trates the region markers.

Moving the Region Markers
The region markers can be moved independently by either of two methods:

1. With the mouse: Move the spectrum cursor to the outside edge of the marker
you want to move. When the cursor turns into a vertical bar with an arrow
attached to it (see Figure 17 on page 15), dragging with the mouse will move
the region marker.

2. From the keyboard: First, use the keypad’s arrow keys to move the spectrum
cursor to the new location for a region marker. Press CTRL+L for the Left
marker or CTRL+R for the Right marker and the selected marker will jump to
the cursor location.

In addition, a keyboard command, CTRL+M, is available to the markers from where
ever they happen to be in the Reference (lower) Spectrum to the edges of the Ex-
panded Spectrum. The Expand Mode is covered in detail in “Expanding the Display”
on page 16.
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While the region markers can be moved individually, we’ve found the following to be
the easiest way to quickly place the markers on either side of a peak of interest when
the markers are close together:

1. Move the mouse cursor (not the spectrum cursor) to the region markers.
When it reaches a marker, it will change into a vertical bar with an arrow
attached to it. Dragging the mouse will move that marker.

Figure 17 shows the mouse cursor on the left (with an arrow), the two region
markers and the spectrum cursor, the vertical line at the top of the peak.

2. When the mouse cursor has a left-pointing arrow, it means that you have
selected the left marker for movement. Similarly, a right-pointing arrow
affects only the right marker.

3. Drag the left marker toward the right until it is just to the right of the peak
you want to analyze. You’ll notice that both markers will move together
when you do this, because the left marker will “push” the right marker along
in front of it.

4. Now drag the left marker back to the left until it is at the left edge of the
region you want to analyze. When you do that the right marker will stay
where it was; the markers are now bracketing the region.
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How to Add, Use and Delete ROIs
Since Genie 2000 has the ability to create and use Regions of Interest (ROIs), let’s
take a look at them.

Creating an ROI
In the previous section, you moved the markers so that they would bracket a peak,
which is the first step in creating an ROI. The second step is to press the keyboard’s
INS key to create an ROI between the two markers.

Using the ROIs
When there are ROIs in your spectrum, you can quickly move the markers to the re-
gion you want to examine by:

• Clicking one of the Control Panel’s ROI Index buttons. The (+) button moves
one ROI to the right and the (–) button moves one ROI to the left.

• Using the keypad’s (+) and (–) keys.

• Clicking one of the ROI Index buttons in the Toolbar.

Deleting an ROI
Deleting an ROI is just as easy as entering one. Just Index the markers to the ROI you
want to remove, then press the keyboard’s DEL key.

How to Expand the Display
To create ROIs accurately, you really need to take a closer look at the data, and for
that, we use the expand mode.

Turning Expand On and Off
There are three ways to turn the expand mode on:

• Click on the Control Panel’s Expand On button.

• Press the F8 key on the keyboard.

• Click the Toolbar’s expand icon.

The result will be a display like the one in Figure 18. The Reference Spectrum, the
lower half of the display, contains the full spectrum and the Expanded Region, the
upper half of the display, shows the expanded data.

Turning the expand mode on changes the button’s name to Expand Off, so the next
time you click on it (or press F8), the display will change back to normal.
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The Expand Rectangle
At the spectrum cursor’s location in the Reference Spectrum, you’ll see a large rectan-
gle in the spectrum (Figure 18). What you see in the Expanded Region is the data
within the rectangle.

Moving the Rectangle
To view a different portion of the Reference Spectrum in the Expanded Region, all
you have to do is move the rectangle to a new section of the data. To do that:

1. Move the mouse cursor into the rectangle; it will change into the four-headed
arrow shown inside the Expand Rectangle in Figure 18.

2. Press the left mouse button and drag the rectangle to the new location. The
Expanded Region will track the movement so you can view the data as the
Expand Rectangle is moved.

Viewing the Data in ROIs
You can to move to and examine the ROIs in the Expanded Display by using any of
the methods described in “Using the ROIs” on page 16.

Changing the Size of the Rectangle
To change the amount of data shown in the Expanded Region all you have to do is
change the size and shape of the rectangle. This is done by stretching or shrinking the
rectangle.

17

How to Expand the Display

Figure 18 Expand Has Been Turned On



To change one side of the rectangle:

1. Move the mouse cursor to the side you want to change until it changes into a
horizontal or vertical double-headed arrow (Figure 19).

2. Click and drag the side to the new position.

To change two adjacent sides at the same time:

1. Move the mouse cursor to any corner of the rectangle until it changes into a
diagonal double-headed arrow.

2. Click and drag with the mouse, which moves the rectangle’s corner,
changing the size of the rectangle in two directions at once.

Using either of these two methods you can change the size and shape until the data
you want to view is displayed in the Expanded Region.

Using the Expanded Region
The spectrum cursor, the markers, and adding and clearing ROIs all work in the usual
way in the Expanded Region, allowing you to examine individual data channels and
“fine tune” your ROI locations. When you’ve finished working with the expanded dis-
play, click Expand Off and you’ll be ready to continue.
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How to Describe the Data
When you’ve acquired a spectrum, the next step is to enter some descriptive informa-
tion before saving it for later analysis.

Editing the Sample Information
There are two ways to open the Sample Information dialog box shown in Figure 20:

• Select the menu’s Edit | Sample info command.

• Click the Toolbar’s edit sample information icon.

The Sample Information editor lets you add a description of the sample to the data file.
Note this information does not have to be entered at this time; it can be added at
analysis time.

Most of the fields in this dialog box are for descriptive purposes only. That is, the text
you type in is stored with the data and will be included with the analysis reports to
provide a better description of the sample.

You can also enter information in the sample Quantity, Uncertainty, Units, Sample
Geometry, percent Random Error and percent Systematic Error fields, all of which are
used during sample analysis. Their use is beyond the scope of this tutorial; for com-
plete information, refer to “The Information Fields” in your Gamma Acquisition and
Analysis chapter or Alpha Analysis Manual.

Viewing the Sample Information
To see the Sample Information for the current datasource, click on the Next button in
the window’s Status Page area until the SAMPLE INFO page appears. You’ll find a
summary of the information you’ve entered displayed there.
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If the Sample Info page is not available, you can enable it through the Display | Pref-
erences menu selection.

How to Save the Data
There are three ways to save the data and its description:

• Select either the menu’s File | Save command or the Toolbar’s save icon ,
which will save directly to an existing file.

• If there is no existing file, you’ll see the “Save as” dialog box shown in Figure
21, which lets you save to a new file name

• Select the menu’s File | Save as command. You’ll see the “Save as” dialog box
(Figure 21).

Description
For CAM files, you can enter an optional description of up to 32 characters, making it
easier to identify this data file at a later date.

Save as Type
Use the default file type: CAM Files (*.CNF).

File Name
All you need to do is type in the file’s name. The dot and the extension (file type) will
be automatically added by Genie 2000 when you click Save.
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4. Basic Energy Calibration Techniques
Energy calibration establishes a linear relationship between the spectrum’s channels
and their energy levels. By calibrating two peaks, one at each end of the spectrum, the
energy of any other peak can be estimated fairly accurately.

Though Genie 2000 Spectroscopy Analysis includes several methods for Energy Cali-
brating a spectrum, we’ll use only one of these methods in the tutorial.

Calibration Setup
Before we create a new energy calibration, we’ll take a look at a system-wide parame-
ter used in energy calibration. Select Calibrate | Setup to see the screen in Figure 22.

You can see two Tolerance parameters in the upper right corner of the window. The
first parameter, Energy Cal, is used in Energy Calibration, discussed below; the
second parameter, Eff Match, is used in Efficiency Calibration (page 25).

Energy Cal Tolerance
During energy calibration, the spectrum’s peaks are matched with the energies speci-
fied in the selected certificate file, plus or minus this tolerance value. The default value
of 1.50 keV means that if a spectrum’s peak is within 1.50 keV of a matching energy
in the certificate file, it will be accepted as valid.
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If you use a higher value, more of the spectrum’s peaks will be seen, which could lead
to false peaks being accepted. On the other hand, using a lower value may cause valid
peaks to be overlooked. Determining the best setting for a given spectrum is beyond
the scope of this tutorial, so we’ll leave the parameter set to its default value.

How to Create a New Energy Calibration
To create a new Energy Calibration, we’ll look at calibration by Certificate File. A
mixed radionuclide calibration source includes a certificate that defines the source’s
radionuclides, their peak energies, the calibrated activity for each, and so forth. A Cer-
tificate File is this information stored in a computer file.

• For details on the other Energy Calibration methods, refer to the “Energy Only
Calibration”, “Energy Full”, and “Energy Calibration | Full” subsections of the
“Calibrate Menu” section in your Gamma Acquisition and Analysis chapter of,
or the Alpha Analysis Manual in, the Genie 2000 Operations Manual.

• For information on how Certificate Files are created and maintained, refer to the
Using the Certificate File Editor chapter in your Genie 2000 Operations Man-
ual.

A. Starting the Calibration
Since we’ve already opened a datasource (page 11), we’ll calibrate its spectrum by en-
tering peak locations and their corresponding energies.

1. Click on Calibrate | Energy Full | By Certificate File.

2. In the Open Certificate File box, double click on Nbsstd.ctf.

The energies of the peaks in the datasource will be loaded into the calibration list for
you (Figure 23).
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To establish an energy calibration, we have to locate at least two of the datasource’s
peaks, one at the low end of the spectrum and one at the high end, which correspond to
the energy of the entries in the calibration file, ±1.50 keV, the Energy Calibration Tol-
erance value.

B. Entering the Peak Locations
The first energy line in Figure 23 is 88.04, which is the line for 109Cd. To enter that
peak, place the spectrum cursor on the 88 keV peak at the low end of the spectrum,
then click the Cursor button to add the cursor’s channel position to the Channel col-
umn. The FWHM and Low Tail values will be calculated and added to the list.

Now scroll down the list in Figure 23 to the 1836 line (88Y), place the spectrum cursor
on the 88Y peak at the high end of the spectrum, then click the Cursor button to add
the cursor’s channel position.

C. Viewing the Energy Calibration
To view the new calibration, click the Show button to see the display in Figure 24.

Below the graph, you’ll see the Datasource’s file name and the equation’s values for
Energy, FWHM and Low Tail.

23

How to Create a New Energy Calibration

Figure 24 A Two-Point Energy Calibration Graph



D. Labeling the Peaks
When the spectrum is calibrated, select Display | Preferences. On the left side of the
Display Preferences dialog (Figure 25), check the Display Nuclide ID on Spectrum
and Display Peak Information checkboxes.

This will add two kinds of peak information to the spectral display: Peak Labels, iden-
tifying the nuclide for each peak, and a Peak Information Bubble for the current peak,
listing the peak’s: Nuclide ID, Energy, Net Area with percent error and the nuclide’s
Activity (optional).

24

Basic Energy Calibration Techniques

Figure 25 The Display Preferences Dialog

Figure 26 Nuclide IDs and 60Co Peak Information



5. Basic Efficiency Calibration Techniques
Put very simply, a detector’s efficiency changes at different levels of gamma-ray en-
ergy. The efficiency calibration allows us to compensate for these changes.

Assuming you’ve gone through the procedures on Energy Calibration and the use of
Certificate Files, you’ll find Efficiency Calibration to be a similar process.

To create an efficiency calibration, your spectrum must be energy calibrated. If you
haven’t done that yet, go back to page 22 and follow the procedure in “How to Create
a New Energy Calibration”.

Eff Match Tolerance
The Efficiency Match Tolerance parameter (Eff Match in Figure 27) is used during ef-
ficiency calibration to match calculated peaks with the peaks in the specified certifi-
cate file, plus or minus the specified tolerance value.

The default value of 1.00 keV means that if a spectrum’s peak is within 1.00 keV of a
matching energy in the certificate file, it will be accepted as valid.

If you use a higher value, more of the spectrum’s peaks will be seen, which could lead
to false peaks being accepted. On the other hand, using a lower value may cause valid
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peaks to be overlooked. Determining the best setting for a given spectrum is beyond
the scope of this tutorial, so we’ll leave the parameter set to its default value

How to Create a New Efficiency Calibration
To create a new Efficiency Calibration, we’ll use calibration by Certificate File, which
is similar to the Energy Calibration by Certificate File process.

• For details on the other Efficiency Calibration methods, refer to the “Calibrate
Menu | Efficiency” section in your Gamma Acquisition and Analysis chapter or
Alpha Analysis Manual.

• For information on how Certificate Files are created and maintained, refer to the
Using the Certificate File Editor chapter in your Genie 2000 Operations Man-
ual.

A. Starting the Calibration
To calibrate the spectrum, we have to enter peak locations and their corresponding en-
ergies.

1. Click on Calibrate | Efficiency | By Certificate File.

2. In the Open Certificate File box, double click on Nbsstd.ctf (the same
Certificate File we used in Energy Calibration).

The energy lines in this file will populate the list box, as shown in Figure 28.
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B. Adding the Efficiency Data
The next step is to add efficiency and percent error values to each energy in the list.
There are two ways to do this:

• If you know that the current datasource contains peak area analysis results, you
can click the Use-results button to populate the list box with that data. If you’re
not sure whether the current datasource contains peak area data, you’ll have to
use the second method.

• Click the Auto button to have the system automatically perform a Peak Locate
and Peak Area analysis, then calculate and display the efficiency and percent er-
ror values for each energy in the list box.

With either method, for each peak found that matches one in the list box, ±1.00 keV,
the Efficiency Match Tolerance value, an efficiency is calculated based on the peak
net area and the calibration data contained in the Certificate File.

Dual Polynomial Curve
For the dual polynomial curve, the overall Efficiency Curve can be a combination of
two curves, one for the lower energies and a second for the higher energies (above
150–200 keV or so).

To use two curves, highlight an energy, then click the Cross-over button to specify
the point where you want the low energy curve to end and the high energy curve to
start. If no crossover point is specified, a single equation is used across the entire en-
ergy range.

1, Click on the 165.85 keV line in the list to select it.

2. Click the Cross-over button to put an X to the right of the peak in the list.
This will mark it as the energy used as the crossover point.

Peak Edits
The Peak Edits section lets you enter or change the Energy, Efficiency, and Error
(%) data by hand. You can use up to 45 calibration triplets; any more than that will be
ignored. The Accept button verifies the entered values and displays them in the list
box; the Delete button deletes the highlighted entry from the list box.

Cascade Correction
The Cascade Correction function, which is enabled only under certain conditions, pro-
duces an efficiency calibration that is free from cascade summing effects. Its use is be-
yond the scope of this tutorial. You’ll find a full description of this function in the
Correcting for Cascade Summing appendix of the Genie 2000 Operations Manual.
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C. Viewing the Efficiency Calibration
To check the results of the Efficiency Calibration, click on the Show button, which
will display the dual efficiency curves and the fit to the data points.

The Dual Energy Curves
The low energy curve, a second order equation, is shown in red (white in Figure 29);
the high energy curve, a fifth order equation, is shown in blue (black in the figure).
The two share the data point at 165.85 keV to ensure continuity from one curve to the
other.

In addition to the default Dual Curve, you can display the calibration as an Empirical
Curve, a Linear Curve or an Interpolated Curve by selecting the appropriate button in
the Curve section of the data window.

To return to the Efficiency Calibration screen, click OK or Cancel.

D. Accepting the Efficiency Calibration
When you are satisfied with the calibration, click OK to have this calibration become
your current calibration.
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6. Basic Spectroscopy Analysis Techniques
Now that we have a calibrated system let’s look at Genie 2000’s  analysis and report-
ing routines. We’ll also find that the reports generated by the basic routines can
include the calibration used during the analysis.

What Are Analysis Modules?
Before we discuss the analysis modules, such as peak locate and area measurements,
we’ll examine the philosophy behind them.

All of the Genie 2000 analyses use modules: programs that take one data set – such as
spectral data – perform a process on it, then output the results – such as peak centroid
locations. Depending on the options installed on your system, you’ll find modules for
functions like Peak Location, Peak Area Measurement and Nuclide Identification.

All of these modules share the following general features:

• All look to the datasource for their input data.

• All (with one exception) place their results back into the datasource so other
modules can use that data. For example, the output from the Peak Location
Module – Peak Centroids – is used as input data by the Peak Net Area and Nu-
clide ID Modules. Their outputs, in turn, are used as inputs to other modules.

• None, with the one exception, are capable of generating a printed report; all
they can do is get data from a datasource, process it, and send results back to
that datasource.

• The one exception is the Report Module. It doesn’t analyze data; it uses the data
generated by the other modules to create a report.

These modules can be run interactively, as demonstrated in the next section, or stored
as an Analysis Sequence File (ASF) that lets you automatically implement a sequence
of analysis modules as discussed  in “Executing an Analysis Sequence” on page 32.

How Are the Modules Used?
The modules are the building blocks from which you create analysis procedures. For
example, consider the following spectroscopy questions.

• Is Nuclide ‘X’ present in my spectrum?
For this you would use the Peak Locate Module, the Peak Area Module, the Ef-
ficiency Correction Module, the Nuclide ID Module, and the Report Module.
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• Several days (weeks, months) later you’re asked “Since Nuclide X did
not appear to be present, what was its Minimum Detectable Activity
(MDA)?”.
The results from step 1 were stored in the datasource with the data, so all you
have to do is apply the MDA Module to the datasource and run the Report
Module again.

• Are you sure that’s right? What calibration did you use?
Since the calibration equations are also stored in the datasource, all you need to
do is use the Report Module to generate a Calibration Report. The report which
will include the calibration.

In short, by running the modules you need in the order you need them, you can easily
tailor your analyses to answer your questions. And, as you’ll see in “Editing an Analy-
sis Sequence” on page 34, a module’s parameters can easily be modified to refine the
results.

As we just learned, performing an analysis consists of running a series of analysis
modules one after the other, then generating a report. This sequence of events can be
stored as an Analysis Sequence File (ASF). Executing the ASF file automatically per-
forms the stored sequence of events.

Depending on which modules you use and how you modify them, you might have sev-
eral automatic analysis sequences for various types of analyses.

How to Execute a Module Interactively
Before you start defining your own custom analysis sequences, you might ask, “How
do I know just which steps to use and which parameters must be modified to get a par-
ticular job done?”

For this, we’ll look at an individual module, which you can interactively modify and
execute so you can see just what their impact will be. We’ll see how this works by
modifying the Peak Locate module.

Locating the Peaks
You can run the Peak Locate module interactively by selecting Analyze | Peak Lo-
cate | Unidentified 2nd Diff. You’ll see the dialog box in Figure 30.
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The Significance Threshold
The Significance Threshold determines how large a peak must be (relative to the back-
ground) to be recognized as a peak. For instance, if the Threshold is set to 5.00, as in
the figure, running the Peak Locate module will result in 26 peaks being found in the
Nbsstd.cnf spectrum.

To see the effects of a higher setting (less sensitivity), change the Significance Thresh-
old value to 12.00, check the Generate Report checkbox, then click on Execute. When
you look at the results in the Report Window (Figure 31), you’ll see that a higher
threshold (12.00) results in a lower sensitivity: only 17 peaks have been found, nine
less than with a Threshold setting of 5.00.
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The Report Window Option
This is a good time to take a look at the Report Window options. There are commands
to copy the data to the clipboard, to clear the data from the window, and to change the
size of the window for easier report viewing.

Clearing the Report Window
You’ll have to clear the Report Window if you want to display the next report’s data
by itself. If you don’t clear the Report Window, the next report will be appended to the
current report.

There are two ways to clear the window:

• Select the menu’s Options | Report Window | Clear Contents command.

• Click the Toolbar’s clear report icon.

Creating a Printed Report
There are two ways to create a printed record of this report:

• Select the menu’s File | Print Report Window command.

• Click the Toolbar’s print report icon.

How to Execute an Analysis Sequence
As we’ll see in “How to Edit an Analysis Sequence” on page 34, Genie 2000 includes
an editor both for changing a module’s parameters and for custom-assembling the
analysis modules into any type of sequence you may need.

In addition, your custom sequences can be added to the Analyze Menu, allowing you
to tailor your system’s automatic analysis to your specific application needs.

To gain an understanding of what an analysis sequence can do, we’ll examine a se-
quence that’s included with Genie 2000. It automatically executes three analysis mod-
ules in a specified order.

When you select Analyze | Execute Sequence, you’ll see a list of the sequences in-
stalled on your system (Figure 32).

Remember that this tutorial assumes that the Model S501 Gamma Analysis option is
installed on your system, so the list in Figure 32 includes the option’s sequences, as
well as those for the Basic Spectroscopy software.
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To use any sequence, there must be a spectrum in the Gamma window. If a spectrum
is not displayed, open C:\GENIE2K\CAMFILES\Nbsstd.cnf.

Running the Peak Analysis w/Report Sequence
The fourth sequence in the list, Peak Analysis w/Report, runs four modules, or steps,
sequentially. To run the sequence, click on Analyze | Execute Sequence | Peak Anal-
ysis w/Report.

The Report Window will display a report of the Peak Analysis of the spectrum (at the
bottom of Figure 33).
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Creating a Printed Report
There are two ways to create a printed record of this report:

• Select the menu’s File | Print Report Window command.

• Click the Toolbar’s print report icon.

How to Edit an Analysis Sequence
If the standard Peak Analysis sequence isn’t quite what you want, you can edit it. You
can even define entirely new sequences. To open the Analysis Sequence Editor, select
Edit | Analysis Sequence. You’ll see the dialog box in Figure 34.

As an example of how to use this editor, we’ll modify the standard Peak Analysis
w/Report sequence to make it less sensitive, just as we did interactively.

A. Load the Sequence
To select the sequence to be edited, click on the Load button. You’ll see the dialog
box in Figure 35, which lets you pick the sequence to be loaded into the editor.
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The Seq. Descriptions list in Figure 35 shows all of the Sequences in the Analyze
Menu. The one we want to change is Peak Analysis w/Report. Double click on its
name to load its steps into the Edit Analysis Sequence window’s Current Steps list, as
shown in Figure 36.

In the Current Steps window, you’ll see the four steps in this sequence:

• Reporting – Standard

• Peak Locate – Unidentified 2nd Difference
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• Peak Area – Sum/Non-linear LSQ Fit

• Reporting – Standard.

The report module is run twice because each instance uses a different section of the
Analysis template to create its part of the report. When the first instance runs, the
report Header is created. When the second instance runs, the Peak Analysis report is
sent to the Report Window.

The second step in the sequence is the Peak Locate module we ran interactively. Since
we already know how to use this module interactively, we’ll use it again as to see how
it can be modified and run in a sequence.

B. Modify the Peak Locate Step
To modify the step’s parameters, double click on Peak Locate – Unidentified 2nd
Diff in the Current Steps list to open the Peak Locate Setup dialog in Figure 37.

Since we want to change the sensitivity, we’ll edit the Significance Threshold param-
eter to show 12.00 as the new value, as we did for the interactive version. When
you’re finished, click on OK to return to the Edit Analysis Sequence dialog box.

C. Store the Modified Sequence
You have two options here: Save the changes to the original ASF file or save the
changes to a new ASF file.

Saving to the Original File
To save the changed Significance Threshold value to the original file:
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1. Click the Edit Analysis Sequence screen’s Store button. You’ll see the Store
Analysis Sequence dialog box in Figure 38.

2. Click OK to save the changed definition.

Saving to a New File
To save the changed Significance Threshold value to a new file:

1. Click the Edit Analysis Sequence screen’s Store button.

2. Type a new file name, such as Peak_NEW, in the File name box (Figure 39).

3. Type a new description in the Seq. Description box. Since this description
will be the sequence’s name in your Execute Sequence Menu, it should be
both meaningful and fairly short. For this example, the revised sequence has
been named Peak Analysis w/Less Sensitivity.
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4. After you’ve completed your entries, click on OK to save the definition.

Using the procedures we’ve just covered, you can create any number of custom se-
quences or edit existing sequences. For further information on defining a sequence, re-
fer to the “Edit Menu | Analysis Sequence” section of your Gamma Acquisition and
Analysis chapter or Alpha Analysis Manual.

D. Use the Modified Sequence
To use the new definition file, click on OK in the Edit Analysis Sequence dialog box
to close it, then click on Analyze | Execute Sequence in the Menu Bar. Your new se-
quence will be at the end of the list (Figure 40).

Creating Your Own Sequence
Creating a sequence isn’t any more complicated than modifying the parameters of the
Peak Locate – Unidentified 2nd Difference step. The only difference is that you’ll be
modifying the parameters of several modules instead of just one.

Of course, it’ll take a little study to determine which modules will be best for your se-
quence. You’ll find that referring to either of the following documents will be very
useful for that study.

All of the modules are fully described in the “Analyze Menu” section of your Gamma
Acquisition and Analysis chapter or Alpha Analysis Manual.
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Glossary

Underlined terms are defined elsewhere in this glossary. These terms and their cross refer-
ences can also be researched online at http://www.canberra.com.

A

ABSORBED DOSE Absorbed dose is the
amount of energy deposited in any material
by ionizing radiation. It is a measure of en-
ergy absorbed per gram of material. The SI
unit of absorbed dose is the gray. The spe-
cial unit of absorbed dose is the rad.

ACCURACY The degree of agreement be-
tween an individual measurement or aver-
age of measurements and the accepted
reference value of the quantity being mea-
sured. See also precision.

ACTIVATION ANALYSIS A method of chemi-
cal analysis (for small traces of material)
based on the detection of characteristic
radionuclides in a sample after it has been
subjected to nuclear bombardment.

ADC Analog to Digital Converter. A device
which changes an analog signal to a digital
signal.

AIM Acquisition Interface Module: a type of mul-
tichannel analyzer.

ALGORITHM A set of well-defined rules for
solving a problem.

ALARA Since exposure to radiation always car-
ries some risk, the exposure should be kept
"As Low As Reasonably Achievable", as de-
fined by 10 CFR 20.

ALPHA PARTICLE [Symbol: ] A particle
made up of two neutrons and two protons; it
is identical to a helium nucleus and is the
least penetrating of the three common types
of radiation (the other two are beta particles
and gamma rays), being stopped by a sheet
of paper or a few centimeters of air. An al-
pha-emitting substance is generally not dan-
gerous to a biological system, such as the
human body, unless the substance has en-
tered the system. See decay.

AMPLIFICATION The process by which weak
signals, such as those from a detector are
magnified to a degree suitable for measure-
ment.

ANALOG MULTIPLEXER An electronic instru-
ment that accepts several inputs and stores
each one in a separate section of MCA
memory. Also called a mixer/router.

ANNIHILATION RADIATION Radiation pro-
duced by the annihilation of a positron and
an electron. For particles at rest, two pho-
tons with an energy of 511 keV each are
produced.

ANTICOINCIDENCE CIRCUIT A circuit with
two inputs. The circuit delivers an output
pulse if one input receives a pulse within a
predetermined time interval, usually on the
order of milliseconds, but not if both inputs
receive a pulse. A principle used in pulse
height analysis. See also coincidence cir-
cuit.

AREA The number of counts in a given region
of a spectrum that are above the continuum
level.
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ASCII An acronym for American Standard Code
for Information Interchange, a method for
encoding alphabetical, numeric, and punctu-
ation characters and some computer control
characters.

ATTENUATION CORRECTION Correction to
the observed signal for the attenuation of ra-
diation in a material between the sample
and the detector or within the sample itself.

B

BACKGROUND RADIATION Radiation due to
sources other than the sample, such as cos-
mic rays, radioactive materials in the vicinity
of a detector or radioactive components of
the detection system other than the sample.

BACKGROUND SUBTRACTION The statisti-
cal process of subtracting the background
level of radiation from a sample count.

BACKSCATTERING The process of scattering
or deflecting into the sensitive volume of a
measuring instrument radiation that origi-
nally had no motion in that direction. The
process is dependent on the nature of the
mounting material, the shield surrounding
the sample and the detector, the nature of
the sample, the type of energy of the radia-
tion, and the geometry. See also scattering.

BASELINE In biology, a known base state from
which changes are measured. In electron-
ics, a voltage state (usually zero volts) from
which a pulse excursion varies.

BECQUEREL [Symbol: Bq] The SI unit of ac-
tivity, defined as one disintegration per sec-
ond (dps).

BETA PARTICLE [Symbol: ] An elementary
particle emitted from a nucleus during radio-
active decay with a single electrical charge
and a mass equal to 1/1837 that of a proton.
A negatively charged beta particle is identi-
cal to an electron. A positively-charged beta
particle is called a positron.

BIOLOGICAL HALF-LIFE [Symbol: Tb] The
time required for a biological system to elimi-
nate half of the amount of a substance (such
as radioactive material) by natural pro-
cesses. Compare effective half-life and
half-life.

BREMSSTRAHLUNG Radiation produced by
the sudden deceleration of an electrically
charged particle when passing through an
intense electrical field.

C

CASCADE SUMMING Also referred to as true
coincidence summing, it occurs when two or
more pulses from the same decay are
summed because they deposit energy in the
detector at the same time. It is a function of
the measurement efficiencies and occurs
only with susceptible cascading nuclides
(60Co, 88Y, 152Eu, 133Ba, etc.)

CENTROID The center of a peak; usually not
an exact channel number.

CHANNEL One of an MCA’s memory locations
for storage of a specific level of energy or di-
vision of time.

CHERENKOV RADIATION Photons emitted
from polarized molecules when returning to
their ground state following excitation by
charged particles traveling faster than the
speed of light in a transparent medium.

CHI-SQUARE TEST A general procedure for
determining the probability that two different
distributions are actually samples of the
same population. In nuclear counting mea-
surements, this test is frequently used to
compare the observed variations in repeat
counts of a radioactive sample to the varia-
tion predicted by statistical theory.

COINCIDENCE CIRCUIT A circuit with two in-
puts. The circuit delivers an output pulse if
both inputs receive a pulse within a prede-
termined time interval, usually on the order
of milliseconds, but not if just one input re-
ceives a pulse. A principle used in pulse
height analysis. See also anticoincidence
circuit.
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COINCIDENCE SUMMING A process where
the signal from two or more gamma rays
emitted by a single decay of a single
radionuclide occur within the resolving time
of the detector end up being recorded to-
gether as a single event so that the recorded
event is not representative of the original de-
cay. Typically causes counts to be lost from
the full energy peaks, but may also cause
addition to the full energy peaks. Coinci-
dence summing is a function of the sam-
ple-to-detector geometry, and the nuclide’s
decay scheme. It is not a function of the
overall count rate.

COLLECT An MCA function that causes stor-
age of data in memory.

COMPTON SCATTERING Elastic scattering of
photons in materials, resulting in a loss of
some of the photon’s energy.

CONFIDENCE FACTOR It is common practice
when reporting results to assign them a con-
fidence level: the value plus or minus one
standard deviation. radiation protection mea-
surements are usually reported at the 95%
confidence level, meaning that the results
would be expected to be within plus or mi-
nus that range 95 out of 100 times. Also
called Confidence Level.

CONTINUUM A smooth distribution of energy
deposited in a gamma detector caused by
the partial absorption of energy from pro-
cesses such as Compton scattering or
bremsstrahlung.

CONVERSION GAIN The number of discrete
voltage levels (or channels) that the ADC’s
full scale input is divided into.

CONVERSION TIME The time required to
change an input signal from one format to
another, such as analog to digital, or time
difference to pulse amplitude; contributes to
dead time.

COSMIC RAYS Radiation, both particulate and
electromagnetic, that originates outside the
earth’s atmosphere.

COUNT A single detected event or the total
number of events registered by a detection
system.

CRITICAL LEVEL (Lc) The level below which a
net signal cannot reliably be detected. See
also detection level.

CROSSOVER ENERGY In some efficiency cali-
bration models, the energy at which one cal-
ibration curve is changed into a second
calibration curve. This is used in the Dual Ef-
ficiency Calibration in Genie software.

CURIE [Symbol: Ci] The (approximate) rate of
decay of 1 gram of radium; by definition
equal to 3.7 x 1010 becquerels (or disintegra-
tions per second). Also, a quantity of any nu-
clide having 1 curie of radioactivity.

D

DATASOURCE A hardware device or a file
which stores data acquisition parameters
and spectral data.

DAUGHTER NUCLIDE A radionuclide pro-
duced by the decay of a parent nuclide.

DEAD TIME The time that the instrument is
busy processing an input signal and is not
able to accept another input; often ex-
pressed as a percentage. See also live time.

DECAY The disintegration of the nucleus of an
unstable atom by spontaneous fission, by
the spontaneous emission of an alpha parti-
cle or beta particle, isomeric transitions, or
by electron capture.

DEFAULT The value of a parameter used by a
program in the absence of a user-supplied
value.

DERIVED AIR CONCENTRATION (DAC) The
concentration (Bq/m3) of a radionuclide in air
that if breathed by Reference Man for a
working year (2000 hours) under light activ-
ity conditions would result in the annual limit
on intake (ALI) by inhalation.

DETECTION LEVEL The level of net signal that
can be predicted to be detectable. See also
critical level.
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DETECTOR A device sensitive to radiation
which produces a current or voltage pulse
which may or may not correspond to the en-
ergy deposited by an individual photon or
particle.

DIGITAL STABILIZATION The monitoring of
one or two reference peaks in a spectrum,
one for gain and one for zero, to correct for
drift in the system electronics.

DISCRIMINATOR An electronic circuit which
distinguishes signal pulses according to
their pulse height or voltage so that un-
wanted counts can be excluded.

DISINTEGRATION See decay.

DPM Disintegrations per minute. One DPM
equals 1/60 becquerel.

DOSE The radiation delivered to the whole hu-
man body or to a specified area or organ of
the body. This term is used frequently in
whole body counting applications.

DOUBLE ESCAPE PEAK See escape peak.

E

EFFECTIVE HALF-LIFE [Symbol: Teff] The
time required for a radioactive element in a
biological system, such as the human body,
to be reduced by one-half as a result of the
combined action of radioactive decay and
biological elimination. Compare half-life and
biological half-life.

EFFICIENCY The fraction of decay events from
a standard sample seen by a detector in the
peak corresponding to the gamma ray en-
ergy of the emission, and stored by a detec-
tion system. Also called Peak Efficiency.
Used to calibrate the system for quantitative
analyses. Also used to specify germanium
detectors, where the relative efficiency of the
germanium detector is compared to a stan-
dard (3 x 3 in.) NaI(Tl) detector. Compare to-
tal efficiency.

EFFICIENCY CALIBRATION A function, a
lookup table, or series of functions, which
correlate the number of counts seen by the
detection system in specific peaks with
known activity corresponding to such emis-
sion energies in a radioactive sample.

ELASTIC SCATTERING See scattering.

ELECTRODEPOSITION A process for coating
the surface of samples being prepared for
alpha spectroscopy and alpha/beta count-
ing.

ELECTROMAGNETIC RADIATION A general
term to describe an interacting electric and
magnetic wave that propagates through vac-
uum at the speed of light. It includes radio
waves, infrared light, visible light, ultraviolet
light, X rays and gamma rays.

ELECTRON [Symbol: e¯] An elementary parti-
cle with a unit negative electrical charge and
a mass 1/1837 that of the proton. Electrons
surround the positively charged nucleus and
determine the chemical properties of the
atom.

ELECTRON VOLT [Symbol: eV] The amount
of kinetic energy gained by an electron as it
passes through a potential difference of 1
volt. It is equivalent to 1.602 x 10-19 joules
per second. It is a unit of energy, or work,
not of voltage.

ENERGY CALIBRATION A function which cor-
relates each channel in the displayed spec-
trum with a specific unit of energy. Allows
peaks to be identified by their location in the
calibrated spectrum.

ESCAPE PEAK A peak in a gamma ray spec-
trum resulting from the pair production pro-
cess, the subsequent annihilation of the
photons produced, and escape from the de-
tector of the annihilation photons. If both an-
nihilation photons escape, and the rest of
the original gamma energy is fully absorbed,
a double escape peak is produced at an en-
ergy equal to the original gamma ray energy
minus 1.022 MeV. If only one of the photons
escapes, a single escape peak is produced
at an energy equal to the original gamma
ray energy minus 511 keV.
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EXCITED STATE The state of molecule, atom,
or nucleus when it possesses more than its
ground state energy. Excess molecular or
atomic energy may be reduced through
emission of photons or heat. Excess nuclear
energy may be reduced through emission of
gamma rays or conversion electrons or by
further decay of a radionuclide.

eV See electron volt.

F

FACTORS The parameters used by an algo-
rithm for its calculations.

FULL ENERGY ABSORPTION The absorption
and detection of all of the energy of an inci-
dent photon. May take place as a direct
photoabsorption or as a result of multiple
Compton scatterings of the incident photons
within the resolving time of the detection
system.

FULL ENERGY PEAK The peak in an energy
spectrum of X-ray or gamma-ray photons
that occurs when the full energy of the inci-
dent photon is absorbed by the detector.

FWHM (Full Width at Half Maximum) The full
width of a peak measured at one-half of its
maximum amplitude with the continuum re-
moved. Defines the resolution of a spectros-
copy system.

G

GAIN, ADC See conversion gain.

GAIN, AMPLIFIER The ratio of the amplifier’s
output signal to its input signal.

GAIN CONTROL A control used to adjust the
height of a pulse received from the detecting
system.

GAMMA RAY [Symbol: ] A photon or
high-energy quantum emitted from the nu-
cleus of a radioactive atom. Gamma rays
are the most penetrating of the three com-
mon types of radiation (the other two are al-
pha particles and beta particles) and are
best stopped by dense materials such as
lead.

GAUSSIAN FIT Calculating the parameters of a
Gaussian (or Normal) function to best match
a set of empirical data (in spectroscopy, the
acquired photopeak histogram). This calcu-
lation is typically performed using a least
squares method after subtracting the
Compton continuum underlying the peak.

GAUSSIAN PULSE SHAPE A pulse shape re-
sembling a statistical bell-curve, with little or
no distortion.

GEOMETRY The detector to sample distance,
the sizes and shapes of the detector, the
sample, and any shielding, all of which affect
the radiation seen by the detector. The ge-
ometry helps define the efficiency of the de-
tector.

GRAY [Symbol: Gy] The SI unit of absorbed
dose, defined as one joule per kilogram of
absorbing medium.

GROUND STATE The state of a nucleus, atom
or molecule at its lowest energy level.

H

HALF-LIFE [Symbol: Tl/2] The time in which
one half of the atoms of a particular radioac-
tive substance decay to another nuclear
form. Half-lives vary from millionths of a sec-
ond to billions of years.

HISTOGRAM A representation of data by verti-
cal bars, the heights of which indicate the
frequency of energy or time events.

I

INELASTIC SCATTERING See scattering.
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ION An atom or molecule that has become
electrically charged by having lost or gained
one or more electrons. Examples of an ion
are an alpha particle, which is a helium atom
minus its two electrons, and a proton, which
is a hydrogen atom minus its single electron.

INDEX An MCA function that jumps the cursor
from one region of interest to another.

INPUT/OUTPUT The process of loading data
into or copying data from an MCA or com-
puter using a peripheral device, such as a
computer, a floppy disk, or a printer.

IN SITU COUNTING Measurement and analy-
sis of radioactivity performed at the sample’s
location.

INTEGRAL The total sum of counts in the re-
gion of interest.

INTENSIFY To change the contrast of a dis-
played region of interest to set it off from
data regions of lesser importance.

INTERACTIVE PEAK FIT The process of refin-
ing and verifying the quality of a peak fit.
The fitting parameters, such as the centroid
location and the way the continuum is de-
fined, can be changed. The change in the
quality of the fit is displayed.

INTERFERING PEAK A peak due to back-
ground radiation which is produced at the lo-
cation of a peak in the sample spectrum or
due to a peak produced by a radionuclide in
the sample at the location of another
radionuclide’s peak.

IN VIVO COUNTING In vivo counting refers to
directly measuring and analyzing
radionuclide activity levels in a living body.

IN VITRO COUNTING In vitro counting refers to
samples, such as tissue or blood, being an-
alyzed for radionuclide activity levels in an
artificial environment (outside of a living
body).

I/O See input/output.

IONIZATION The process by which an electri-
cally neutral atom acquires a charge (either
positive or negative).

IONIZING EVENT Any process whereby an ion
or group of ions is produced. As applied to
nuclear spectroscopy, this refers to the
passing of radiation through a gas, a crystal,
or a semiconductor.

ISOMERIC TRANSITION The de-excitation of
an elevated energy level of a nucleus to the
ground state of the same nucleus by the
emission of a gamma ray or a conversion
electron.

ISOTOPE One of two or more atoms with the
same atomic number (the same chemical el-
ement) but with different atomic weights. An
equivalent statement is that the nuclei of iso-
topes have the same number of protons
(thus the same chemical element) but differ-
ent numbers of neutrons (thus the different
atomic weight). Isotopes usually have very
nearly the same chemical properties, but
somewhat different physical properties. See
also nuclide and stable isotope.

K

keV (kiloelectron volt) One thousand electron
volts.

KEY LINE Designated in nuclide libraries for re-
porting purposes only. It is intended to indi-
cate the highest abundance photopeak
energy for nuclides with multiple energy
lines, or the line that is the least likely to
have interferences.

L

LAN Local area network: a network of two or
more computers connected together.

Lc See critical level.
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LIBRARY DIRECTED PEAK SEARCH Method
of designating the location of peaks using all
of the lines from the specified nuclide library.
All of the nuclide library energies are as-
sumed to have photopeaks present and the
peak analysis is typically required to verify
or reject each peak. This limits the peak
search to the nuclides in the library but al-
lows for greater sensitivity than with typical
unknown peak searches. See also second
difference peak search.

LIMIT OF DETECTION The minimum amount
of the characteristic property being mea-
sured that can be detected with reasonable
certainty by the analytical procedure being
used under specific measuring conditions. If
the conditions change, the limit of detection
will also change, even if the analytical proce-
dure remains the same. See also lower limit
of detection.

LIVE TIME The time that the ADC is not busy
processing a signal. See also dead time and
real time.

LIVE TIME CORRECTION In an MCA, the pro-
cess of stopping the live time clock when-
ever the processing circuits are busy and
cannot accept further information. Com-
monly used to extend the collection time by
accounting for the dead time.

LOWER LIMIT OF DETECTION (LLD) The
smallest net signal that can reliably be quan-
tified. LLD is a measure of the performance
of a system in terms of activity.

LOWER LEVEL DISCRIMINATOR (LLD) An
SCA’s minimum acceptable energy level. In-
coming pulse amplitudes below this limit will
not be passed. See also upper level
discriminator.

M

MARINELLI BEAKER A standard sample con-
tainer that fits securely over a detector
cryostat’s endcap and is used when calibrat-
ing voluminous samples (usually soil or wa-
ter solutions).

MASS NUMBER The sum of the neutrons and
protons in a nucleus. It is the nearest whole
number to an atom’s atomic weight. For in-
stance, the mass number of 235U is 235.

MAXIMUM PERMISSIBLE CONCENTRATION
(MPC) The concentration limit for a given

radionuclide in air or water in determining
possible inhalation, ingestion or absorption
for health physics controls.

MCA See multichannel analyzer.

MCS See multichannel scaling.

MDA Minimum detectable activity. See lower
limit of detection.

MEAN The average of a group of numbers.

METASTABLE ISOTOPE A long-lived energy
state of a particular nuclide that is not its
ground state. Some nuclides have more
than one isomeric state. An isomeric state
has the same mass number and atomic
number as the ground state, but possesses
different radioactive properties.

MeV (megaelectron volt) One million electron
volts.

MIXER/ROUTER See analog multiplexer.

MONITORING, PERSONNEL Periodic or con-
tinuous observation of the amount of radia-
tion or radioactive contamination present in
or on an individual.

MULTICHANNEL ANALYZER (MCA) An in-
strument which collects, stores and ana-
lyzes time-correlated or energy-correlated
events. See also multichannel scaling and
pulse height analysis.

MULTICHANNEL SCALING (MCS) The acqui-
sition of time-correlated data in an MCA.
Each channel is sequentially allocated a
dwell time (a specified time period) for accu-
mulating counts until all the memory has
been addressed. MCS is useful for studying
rapidly decaying radioactive sources.

MULTISPECTRAL SCALING Also called
multiscaling, or MSS. See multichannel scal-
ing.
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MULTIPLET Peaks in a spectrum which over-
lap each other. Compare singlet.

N

NATURALLY OCCURRING RADIOACTIVE MA-
TERIAL (NORM) Radioactivity that is naturally

present in the earth.

NEUTRON [Symbol: n] An uncharged elemen-
tary particle with mass slightly greater than
that of the proton, and found in the nucleus
of every atom heavier than hydrogen.

NEUTRON ACTIVATION ANALYSIS (NAA)
The process of activating materials by neu-
tron absorption then measuring the emission
of characteristic photons on decay to deter-
mine the relative abundance of elements in
an object.

NID Nuclide Identification, the process of identi-
fying radionuclides by comparing peak ener-
gies detected with entries in a nuclide
library.

NIM Nuclear Instrumentation Module. A nuclear
instrument conforming to the
DOE/ER-00457T standard.

NOISE Unwanted signals on or with a useful
signal which can distort its information con-
tent.

NON-DESTRUCTIVE ASSAY An analysis
method that does not destroy the sample.
For example: gamma spectroscopy, X-ray
fluorescence and neutron activation.

NUCLEAR SAFEGUARDS The general topic of
maintaining control and accountability of
special nuclear materials.

NUCLEUS The positively charged core of an
atom, which contains nearly all of the atom’s
mass. All nuclei contain both protons and
neutrons, except the nucleus of ordinary hy-
drogen, which consists of a single proton.

NUCLIDE A general term applicable to the iso-
topes of all elements, including both stable
and radioactive forms (radionuclides).

NUCLIDE LIBRARY A file listing nuclides, their
names, half-lives, types, energies/lines, and
line abundances. These files are used with
library directed peak searches, nuclide iden-
tification (NID) and as aids in performing cal-
ibrations.

O

OFFSET, ADC A digitally performed shift in the
ADC’s channel zero. Shifts the entire spec-
trum by the selected amount.

OVERLAP An MCA function allowing one sec-
tion of memory to be displayed over another.

P

PAIR PRODUCTION Creation of an elec-
tron-positron pair by gamma ray interaction
in the field of a nucleus. For this process to
be possible, the gamma ray’s energy must
exceed 1.022 MeV, twice the rest mass of
an electron.

PARAMETER A variable that is given a con-
stant value for a specific application.

PARENT NUCLIDE A radionuclide that pro-
duces a daughter nuclide during decay.

PASSIVE NON-DESTRUCTIVE ASSAY A
method that uses radiation emitted by the
sample itself, without increasing the emis-
sion by bombarding the sample with some-
thing, such as neutrons. The sample itself is
not changed in any way in the course of
passive assay.

PEAK A statistical distribution of digitized
energy data for a single energy.

PEAK CHANNEL The channel number closest
to the centroid of a peak.

PEAK FIT The optimization of parameters to
match an expected model shape to empiri-
cal data (see also gaussian fit). This optimi-
zation is typically performed using a least
squares method.
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PEAK-TO-TOTAL RATIO The ratio of the ob-
served counts in a full energy peak to the
counts in the entire spectrum, caused by the
interaction of radiation with the detector at
that emission energy only.

PERCENT SIGMA [Symbol: ] An expression
of the standard deviation as a percentage. It
is numerically equal to 100 times the stan-
dard deviation divided by the mean.

PHA See pulse height analysis.

PHOTOELECTRIC ABSORPTION The process
in which a photon interacts with an absorber
atom, the photon disappears completely,
and the atom ejects a photoelectron (from
one of its bound shells) in place of the pho-
ton.

PHOTOELECTRON An electron released from
an atom or molecule by means of energy
supplied by radiation, especially light.

PHOTOMULTIPLIER TUBE (PMT) A device
for amplifying the flashes of light produced
by a scintillator.

PHOTON In quantum theory, light is propa-
gated in discrete packets of energy called
photons. The quantity of energy in each
packet is called a quantum.

PHOTOPEAK See Peak.

PHYSICAL HALF-LIFE See half-life.

POLE/ZERO A method of compensating the
preamplifier’s output signal fall-time and the
amplifier’s shaping time constant. Its use im-
proves the amplifier’s high count rate resolu-
tion and overload recovery.

PMT See photomultiplier tube.

POSITRON[Symbol: +] An elementary parti-
cle, an “anti-electron”; with the mass of an
electron but having a positive charge. It is
emitted by some radionuclides and is also
created in pair production by the interaction
of high-energy gamma rays with matter.

POSITRON ANNIHILATION A process where a
positron combines with an electron, produc-
ing two annihilation photons of 511 keV
each.

PRECISION The degree of agreement between
several measurements of the same quantity
under specific conditions. See also accu-
racy.

PRIMORDIAL NUCLIDE A nuclide as it exists
in its original state.

PROGENY See daughter nuclide.

PROMPT GAMMA ANALYSIS A form of neu-
tron activation analysis where gammas,
emitted during capture of neutrons, are used
for analysis instead of gammas of subse-
quent beta decay.

PROTON An elementary particle with a single
positive electrical charge and a mass ap-
proximately 1837 times that of the electron.
The atomic number (Z) of an atom is equal
to the number of protons in its nucleus.

PROTON INDUCED X-RAY EMISSION (PIXE)
The emission of X ray when a sample is
bombarded by protons. The X rays emitted
are characteristic of the elements present in
the sample. Used for trace analysis.

PULSE HEIGHT ANALYSIS (PHA) The acqui-
sition of energy-correlated data in the MCA.
Each channel, defined as an energy win-
dow, is incremented by one count for each
event that falls within the window, producing
a spectrum which correlates the number of
energy events as a function of their ampli-
tude.

PULSE PAIR RESOLUTION The ability to dis-
criminate between two pulses close together
in time.

PULSE PILEUP A condition, where two energy
pulses arrive at nearly the same time, which
could produce false data in the spectrum.

PULSE PILEUP REJECTOR (PUR) An elec-
tronic circuit for sensing the pulse pileup
condition and rejecting these pulses so that
only single pulses are counted.

47



Q

QUANTUM The unit quantity of energy accord-
ing to quantum theory. It is equal to the
product of the frequency of the electromag-
netic radiation and Planck’s constant (6.626
x 10-34 J/s).

R

RAD A special unit of absorbed dose. Equal to
0.01 gray.

RADIATION The emission or propagation of
energy through matter or space by electro-
magnetic disturbances which display both
wave-like and particle-like behavior. Though
in this context the “particles”; are known as
photons, the term radiation has been ex-
tended to include streams of fast-moving
particles. Nuclear radiation includes alpha
particles, beta particles, gamma rays and
free neutrons emitted from an atomic nu-
cleus during decay.

RADIOACTIVITY The emission of radiation
from the spontaneous disintegration (decay)
of an unstable nuclide.

RADIONUCLIDE A radioactive isotope. See
also nuclide.

RANDOM SUMMING A process where the sig-
nal from two or more separate decays of the
same radionuclide or different radionuclides
that occur within the resolving time of the
detector end up being recorded together as
a single event so that the recorded event is
not representative of the original decays.
Typically causes counts to be lost from the
full energy peaks. Random summing is a
function of the overall count rate, or the ac-
tivity of the sample being measured.

RANDOM SUMMING LOSS The loss of counts
from the full energy peaks due to random
summing.

RANGE, ADC The full-scale address (number
of channels) of the ADC’s assigned memory
segment.

REAL TIME Elapsed clock time; also called true
time. Compare live time.

RECOILING NUCLEUS A nucleus that gains
significant kinetic energy from its decay.

REGION OF INTEREST (ROI) A user-defined
area of the spectrum which contains data of
particular interest, such as a peak.

REM (Roentgen Equivalent Man) A unit of
dose equivalency; equal to 0.01 sievert. See
also Roentgen.

RESOLUTION The ability of a spectroscopy
system to differentiate between two peaks
that are close together in energy. Thus, the
narrower the peak, the better the resolution
capability. Measured as FWHM.

ROENTGEN The Roentgen, the international
unit of X radiation or gamma radiation, is the
amount of radiation producing, under ideal
conditions in one cc ionization of either sign
equal to one electrostatic unit of charge.

ROI See region of interest.

S

SCA Single Channel Analyzer. A device which
recognizes events (pulses) occurring be-
tween the settings of the lower level
discriminator and the upper level
discriminator. In an MCA, each event within
these limits is counted; events outside of
these limits are discarded.

SCATTERING A process that changes a parti-
cle’s trajectory. Scattering is caused by par-
ticle collisions with atoms, nuclei and other
particles or by interactions with electric or
magnetic fields. If there is no change in the
total kinetic energy of the system, the pro-
cess is called elastic scattering. If the total
kinetic energy changes due to a change in
internal energy, the process is called inelas-
tic scattering. See also backscattering.

SCINTILLATOR A type of detector which pro-
duces a flash of light as the result of an ion-
izing event. See also photomultiplier tube.
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SECOND DIFFERENCE PEAK SEARCH A
technique for locating photopeaks by calcu-
lating the second difference for each chan-
nel in a spectrum, then locating areas of
negative concavity. See also library directed
peak search.

SEGMENTED GAMMA SCANNER A gamma
spectroscopy system that analyzes a sam-
ple by counting it in discrete segments.

SELF ABSORPTION Absorption of the photons
emitted by the radioactive nuclides in the
sample by the sample material itself.

SHADOW SHIELD An attenuating enclosure
that shields the detector from direct back-
ground radiation without being a 4π; shield.
Typically used in whole body counting.

SHAPE CALIBRATION The process of estab-
lishing a relationship between the expected
peak shape and energy. A shape calibration
can be established by using two or more
peak FWHM/energy (or FWHM/ channel)
pairs or by using a least squares fit algo-
rithm.

SIEVERT [Symbol: Sv] The SI unit of dose
equivalency (a quantity used in radiation
protection). The sievert is the dose equiva-
lent when the absorbed dose of ionizing ra-
diation multiplied by the dimensionless
factor Q (quality factor) and N (product of
any other multiplying factors) stipulated by
the International Commission on Radiologi-
cal Protection is one joule per kilogram.

SINGLE CHANNEL ANALYZER See SCA.

SINGLE ESCAPE PEAK See escape peak.

SINGLET A single peak in a spectrum, well
separated from other peaks. Compare
multiplet.

SMOOTHING To decrease the effects of statis-
tical uncertainties in computerized spectrum
analysis, the content of each channel is re-
placed by a weighted average over a num-
ber of adjacent channels.

SPECIFIC ACTIVITY The quantity of radioactiv-
ity per unit mass; for example, dpm/g or
Bq</A>/g.

SPECIAL NUCLEAR MATERIAL (SNM) Mate-
rial containing fissionable isotopes suitable
for nuclear weapons.

SPECTRUM A distribution of radiation intensity
as a function of energy or time.

SPECTROMETER A device used to count an
emission of radiation of a specific energy or
range of energies to the exclusion of all
other energies. See also multichannel ana-
lyzer.

STABLE ISOTOPE An isotope that does not
undergo radioactive decay.

STANDARD DEVIATION [Symbol: ] A mea-
sure of the dispersion about the mean value
of a series of observations expressed in the
same units as the mean value.

STRIPPING Subtracting a specified fractional
part of the data in one section of memory
from the data in another section of memory.

SYSTEM BUSY TIME The dead time of an en-
tire spectroscopy system.

T

TOTAL DETECTOR EFFICIENCY All pulses
from the detector are accepted, and all inter-
actions (regardless of how low in energy)
are assumed counted.

TOTAL EFFICIENCY The ratio of all pulses re-
corded in the MCA memory (in all channels)
to the gamma quanta emitted by the sample.
Compare efficiency.

TRANSURANIC (TRU) Possessing an atomic
number higher than that of uranium (92).

TRUE COINCIDENCE SUM PEAK A spectral
peak, the energy of which equals the sum of
the energies of two or more gamma rays or
X ray from a single nuclear event.

TRUE TIME See real time.
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U

UNCERTAINTY In a nuclear decay measure-
ment, uncertainty refers to the lack of com-
plete knowledge of a sample’s decay rate
due to the random nature of the decay pro-
cess and the finite length of time used to
count the sample.

UPPER LEVEL DISCRIMINATOR (ULD) An
SCA’s maximum acceptable energy level.
Incoming pulse amplitudes above this limit
will not be passed. See also lower level
discriminator.

W

WHOLE BODY COUNTING (WBC) In vivo de-
termination of radionuclide activity levels in
the human body. Used to determine compli-
ance with the regulations of various govern-
mental bodies regarding radiation exposure.

WINDOW A term describing the upper and
lower limits of radiation energy accepted for
counting by a spectrometer.

X

X RAY A penetrating form of electromagnetic
radiation emitted during electron transitions
in an atom to a lower energy state; usually
when outer orbital electrons give up some
energy to replace missing inner orbital elec-
trons.

Z

ZERO, ADC An ADC control which aligns its
zero energy output with a specific channel in
the MCA’s memory (usually channel zero).
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Canberra (we, us, our) warrants to the customer (you, your) that for a period of ninety (90) days from the date of
shipment, software provided by us in connection with equipment manufactured by us shall operate in accordance
with applicable specifications when used with equipment manufactured by us and that the media on which the
software is provided shall be free from defects. We also warrant that (A) equipment manufactured by us shall be
free from defects in materials and workmanship for a period of one (1) year from the date of shipment of such
equipment, and (B) services performed by us in connection with such equipment, such as site supervision and
installation services relating to the equipment, shall be free from defects for a period of one (1) year from the date of
performance of such services.

If defects in materials or workmanship are discovered within the applicable warranty period as set forth above, we
shall, at our option and cost, (A) in the case of defective software or equipment, either repair or replace the
software or equipment, or (B) in the case of defective services, reperform such services.

LIMITATIONS
EXCEPT AS SET FORTH HEREIN, NO OTHER WARRANTIES OR REMEDIES, WHETHER STATUTORY,
WRITTEN, ORAL, EXPRESSED, IMPLIED (INCLUDING WITHOUT LIMITATION, THE WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) OR OTHERWISE, SHALL APPLY. IN NO
EVENT SHALL CANBERRA HAVE ANY LIABILITY FOR ANY SPECIAL, EXEMPLARY, PUNITIVE, INDIRECT
OR CONSEQUENTIAL LOSSES OR DAMAGES OF ANY NATURE WHATSOEVER, WHETHER AS A RESULT
OF BREACH OF CONTRACT, TORT LIABILITY (INCLUDING NEGLIGENCE), STRICT LIABILITY OR
OTHERWISE. REPAIR OR REPLACEMENT OF THE SOFTWARE OR EQUIPMENT DURING THE
APPLICABLE WARRANTY PERIOD AT CANBERRA'S COST, OR, IN THE CASE OF DEFECTIVE SERVICES,
REPERFORMANCE AT CANBERRA'S COST, IS YOUR SOLE AND EXCLUSIVE REMEDY UNDER THIS
WARRANTY.

EXCLUSIONS
Our warranty does not cover damage to equipment which has been altered or modified without our written
permission or damage which has been caused by abuse, misuse, accident, neglect or unusual physical or
electrical stress, as determined by our Service Personnel.

We are under no obligation to provide warranty service if adjustment or repair is required because of damage
caused by other than ordinary use or if the equipment is serviced or repaired, or if an attempt is made to service or
repair the equipment, by other than our Service Personnel without our prior approval.

Our warranty does not cover detector damage due to neutrons or heavy charged particles. Failure of beryllium,
carbon composite, or polymer windows, or of windowless detectors caused by physical or chemical damage from
the environment is not covered by warranty.

We are not responsible for damage sustained in transit. You should examine shipments upon receipt for evidence
of damage caused in transit. If damage is found, notify us and the carrier immediately. Keep all packages,
materials and documents, including the freight bill, invoice and packing list.

When purchasing our software, you have purchased a license to use the software, not the software itself. Because
title to the software remains with us, you may not sell, distribute or otherwise transfer the software. This license
allows you to use the software on only one computer at a time. You must get our written permission for any
exception to this limited license.

BACKUP COPIES
Our software is protected by United States Copyright Law and by International Copyright Treaties. You have our
express permission to make one archival copy of the software for backup protection. You may not copy our
software or any part of it for any other purpose.

Revised 1 Apr 03
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